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Warranty Information
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Warnings, Cautions, Notes, and Tips
Refer all service to qualified personnel.  This warns of possible personal injury or equipment damage under noted
conditions.  Follow all safety standards of professional practice and the recommendations in this manual.  Using this
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may void the warranty.

Quality Notice
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Introduction 1

What is eZ-Balance? …… 1
Overview of the Balance Job …… 1
Connecting The ZonicBook for Online Acquisition …… 2
Balance Job Check List …… 2

Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

What is eZ-Balance?
eZ-Balance is a multi-plane balance software package, that will compute the optimal balance weights and
locations based on vibration data.  This data can either be collected by the ZonicBook FFT Analyzer or
entered manually.  You can configure eZ-Balance to have from 1 to 7 balance planes.

The setup includes 1 tach input channel and from 1 to 7 response channels. Accelerometer, Velocity, and
Displacement probes are examples of Response Channels.

You can interactively review the vibration data and balance results in graphical format.  A balance toolkit is
provided for typical balance calculations, such as splitting weights.

Overview of the Balance Job
Each balance “job” in eZ-Balance is unique.

For example, if you have 2 motor driven fans, 201 and 202, you have 2 separate eZ-Balance Jobs, one for
each machine.

Each eZ-Balance Job has its own set of configuration and data files that can be stored and later retrieved.

Each time you create a new eZ-Balance Job, the Job Template configuration is copied to the new
eZ-Balance Job.  The defaults are suitable for most balance jobs.

After you have configured your eZ-Balance Job, you are ready to begin the Balancing Process.  You need
to collect vibration data at several machine conditions (runs).  These runs include the initial run, the trial
run(s), and the optional trim run.  The initial run is the machine’s condition prior to any balance efforts.
The trial run(s) measure the vibration effect of adding trial weights to the balance plane.  Lastly, the
optional trim run measures the final result of your balance efforts.  The number of trial runs is equal to the
number of balance planes.

Vibration data is the vibration amplitude and phase measured at the machine’s running speed (frequency).
These values are commonly referred to as the first order amplitude and phase.  The vibration data can be
either automatically measured using the ZonicBook FFT Analyzer or entered manually using the keyboard.
Enter the trial weight and location values prior to each trial run.

The Control window identifies where you are in the balance process.  After the trial runs have been
completed, you then request eZ-Balance to compute a balance solution.
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Connecting The ZonicBook for Online Acquisition
Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

If you are using the ZonicBook Analyzer to capture data for your balance job, connect your analog input
signals to the ZonicBook’s BNC inputs.  Configure the Dip Switches as needed.  Typically, proximity and
DC proportional signals should be DC coupled; and Accelerometer, Velocity, and Tach signals should be
AC coupled.

Proximity: SE(single ended) DC ICP off
Accelerometer/*Velocity: SE AC ICP  on
Tach: SE AC ICP off

*Velocity can be either ICP on/off depending on the instrument being used.

Balance Job Check List
Determine method for using eZ-Balance (online with a ZonicBook or offline).
If online, start the ZonicBook, verifying all connections and hardware settings.

1. Start eZ-Balance.
2. Create a New eZ-Balance File, or Open a previously saved one using the File Menu options.
3. If you are working online, modify the ZonicBook Configuration via the Edit Menu.
4. Acquire Vibration Data using the ZonicBook or Enter Data Manually for the Initial Run.
5. Add balance weight.
6. Acquire Vibration Data using the ZonicBook or Enter Data Manually for the Trial Run.
7. Repeat Steps 6 and 7 for each plane.
8. Calculate a solution.
9. Add Solution Weights to Balance Plane
10. Acquire Trim Run Vibration Data
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A Balancing Project 2
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1. Start eZ-Balance
To run eZ-Balance, double-click the eZ-Balance icon or use your Windows desktop Start button to navigate
to the program file.

The first time you run eZ-Balance, the Registration Form will open.  You must enter this information for
eZ-Balance to operate.

The Password accompanies the CD-ROM  or in an email if you downloaded eZ-Balance from the Web
Site.  You will not have to re-enter this information again, unless you upgrade to a newer version, or if you
reinstall eZ-Balance.

Registration Form
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After you click OK on the Registration Form the eZ-Balance Main window open.
This window contains a set of windows you will use interactively during your balancing project.

Main Window

2.  Create a New Job
1. On the File Menu, select New eZ-Balance File to open the Save As dialog window.

Save As Dialog

Select or create a folder for your eZ-Balance Project.

We recommend you store all jobs in a separate “Jobs” folder.  This allows for easier file
maintenance.

2. Enter the name for the eZ-Balance Project.
3. Click the <Save> button to create the new project.
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The first time eZ-Balance runs, it automatically loads the default configuration parameters into a
“Job Template.”  This information is located in the Windows directory where you installed eZ-Balance.
Each “eZ-Balance Job” has its own file with the .ezb extension.

3.  Modifying the ZonicBook Setup for On-line Balancing
After you create a new eZ-Balance Job, you need to verify that the default setup is valid for your job.  For
many jobs there is no need to modify the default setup.  To modify the Acquisition and Input Channels
parameters, select ZonicBook on the Edit menu.

These menu options are not available if Data Acquisition is on.

ZonicBook Setup Acquisition Tab
Use this panel to configure the ZonicBook’s Acquisition parameters for your eZ-Balance Job.  If you make
any changes, click the <Save> button.

Balance Configuration   Acquisition Tab
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ZonicBook Setup Channels Tab
Use this panel to configure each channel for your balance job.  Select a channel then set the values for each
attribute.  Repeat for each channel.  [Defaults:  Channel 1 is the Tach, Channel 2 is the Accelerometer.
Channels 3 through 8 are unused (not set up).

Balance Configuration   Input Channels Tab

4.  Input Initial Vibration Data
Balance Data can be acquired with the ZonicBook analyzer (on-line), or it can be entered manually (off-line).

Control Window
Use the Control window to keep track of the balance project’s tasks.   After each step is completed an asterisk is shown
next to the step number.

Control Window

Vibration data acquired
or manually entered
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Polar Display
Note: The data in the graphics are for presentation only and do not represent a real balancing

project.

On-line
Before acquiring vibration data, verify that your ZonicBook is properly connected and
configured.  See the ZonicBook Getting Started manual.

Polar Display Window
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Press the Toggle Switch   in the Analyzer panel to enable data acquisition.

The Polar Display window displays the measured Speed, Overall, 1x Amp, and 1x Phase values.

Polar Display Table

After the machinery reaches a steady state, press      .  This logs the vibration data for the current Run.

Off-line
Enter your data into the Vibration Data window.

After entering the vibration data for the initial run, press, .

Control Window
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5.  Add Balance Weights
View the plotted vibration data and determine where you may need to add balance weights.  Add the
weight to your machinery.  In the Balance Weights window enter the trial weight amount and the angle
used.  Notice how the arrow in the Angle Dial has changed.

    Balance Weights Window

6. Input Data for Trial Run Balancing

Control Window
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Use the same method you used in Step 4 to enter Trial Run Vibration data.  Repeat Steps 5 and 6 for each
Balance Plane.  After each step is completed an “*” is shown next to the step number.

Control Window

7.  Calculate a Solution
Click the Calc Balance Solution button, .

Note that you now have several pieces of information displayed in the Balance Weights window.  In the
Solution area you have the weight and location to place the final correction.  You also have the influence
coefficients.  Under the table of weights and angles you also have the effective weight and angle.

You can see that another arrow (green) has been added to the Angle Dial.

You can now choose to use a Solution with (Keep) or without (Remove) the weight you added.  Select the
radio button of a solution choice to see the values.

Balance Weights
Keep Trial Weights

Balance Weights
Remove Trial Weights
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8.  Add Solution Weights to the Balance Plane
At this time you know how much weight to add and the location.  If you can’t implement the solution as
given.  Click the       button to open the toolbox for assistance in various calculations you may need to
complete your balancing project.

9.  Acquire Trim Run Vibration Data
The Trim run verifies the Balance solution.  To fine-tune the results, repeat the process.
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The Main Window
The Main window is comprised of menus, buttons, and windows needed to complete a balancing project.
This chapter covers the menus and windows used in eZ-Balance.

First the windows and icons will be explained followed by the Menu system.

Main Window
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Task Bar

Task Bar

ZonicBook On/Off  Switch          /
Click the On / Off  toggle switch to start and stop data acquisition.

• On  = up green toggle switch,       .
• Off = down red toggle,        .

Pause/Continue Button        /
Click the < Pause / Continue > button to temporarily halt data acquisition.

• Red = Paused
• Green = Continued

Snapshot Button
Click the < Snapshot > button to save the current acquisition data to the History file.  The History file is
FIFO (first in first out).  The number of records in the file is set in the acquisition tab of the ZonicBook
Configuration window.

Save Runout Compensation Button
Click the < Save Runout Compensation > button to save very low speed (ie. 50 to 200 rpm) data.  The
purpose of this file is to capture vibrations due to mechanical or electrical defects that are inherent in the
structure (i.e. shaft).

Apply Runout Compensation Button
Click the < Apply Runout Compensation > button when your machinery is running at full speed.

Add Vibration Plot Window
Click the < Add Vibration Plot Window > button to open a plot window that contains vibration data from
a response input channel.

Add Balance Weights Window
Click the < Add Balance Weights Window > button to open a balance plane window.  This window is
used to enter the trial weight for each Balance plane.

Show Comments Window
Click the < Show Comments Window > button to open the Comments window.  There is space for five
dated comments in this window.

Show Machine Graphics Window
Click the < Show Machine Graphics Window > button to open the Machine Picture window.
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Balance Toolkit
Click the < Balance Toolkit  > button to open the Balance Toolkit window.  The Balance Toolkit contains
utilities for balancing calculations.

Analyzer Status
The adjacent area on the Task Bar displays the status of the ZonicBook analyzer.

Control Window

Control Window

The Control Window controls the balancing project and acts as a visual aid, tracking the project.  The six
basic steps to complete a balancing project are listed vertically.
(Note:  For mutliplane balancing there are more steps.)

1. The Initial Run data is collected from your unbalanced machine.  Enter the vibration data in the data
cells or use the ZonicBook to capture data on-line.

2. Trial Weights are needed to calculate a balance solution.  Enter the trial weight(s) and location(s) in
the data cells provided in the Balance Weights window.

3. After the trial weights have been physically added to the machine, run the machine again until it
reaches a steady-state; then capture Trial Run 1 data.

4. eZ-Balance now has enough information to Calculate a Solution.
5. Physically add the Solution Weights to the Balance Planes.
6. To verify your solution perform a Trim Run.

Use the control buttons,                           ,  to move through the steps.

Click the Clear All Data button,       , to clear all the response data collected for this job.

Click the Clear Last Run button,      , to delete the last run when you do not want to accept the data from
that run.  This resets the balance job status to the previous run.

Click the Accept Data button,     , when the machinery has reached a steady-state and has collected data
on-line.  This stores the data for the current run.

You can also manually enter the vibration data for each Run.  Click on the desired cell in the table at the
top of the Polar Display window and enter the vibration data.  Press Enter to move down to the next cell.

Click the Begin Next Run button,      , after you have added trial weights to move to the next run.

Click the Solution button,       , to calculate a balance solution.  The correction weights and angles needed
for each balance plane are displayed in the Balance Weights window.
The projected response, after all corrections have been made, is displayed in the Polar Display window.

By default, eZ-Balance includes the trial weights in the balance solution.  You can optionally calculate a
balance solution without the trial weights by selecting the < Remove > radio button.

Click the Add Solution Weights to all Balance Planes button,       , to have eZ-Balance add the solution
weights to the Balance Weights window prior to performing a Trim  Run.
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Vibration Data Display Window

Vibration Data Display Window

The channel buttons                                                 are set up in the ZonicBook Configuration window;
which is accessed via the Edit menu.  The blue and white buttons indicate active response channels.  The
blue button is the channel being displayed.

The Plot button controls the plot display type. Click this button to toggle through the following choices:

Polar Plot
Time Plot
Spectrum Plot

The Scale button controls the plot scale type.  Click this button to toggle through the following choices:   

Auto Scale
Instrument Scale
User Scale

The Format button controls Linear,        and Log,       for spectrum displays.  Click this button to toggle
between the two formats.

Vibration Data Table

The above table contains the vibration data for each balance run.  The data can be entered manually,
or collected on-line by the ZonicBook FFT Analyzer.

The data in the table is displayed in the Polar plot.

Polar Plot
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Balance Weights Window

Balance Weights Window

Each of the buttons at the top of the window represent a Balance plane.  The Blue and White Buttons are
the planes to be balanced.  The Blue button is the selected plane.

Any Location allows you to place weights at any angle.

Fixed Location will insert a list of locations in the table.  When Fixed Location is selected, you have the
option to select the Start Angle and the Number of Locations.

The table shows the amount of Weight added at a specific Angle.

Engineering Units are not listed in this window.   It is up to the user to keep consistent units.

A Red Line in the dial indicates the location of an added weight.

The Blue Arrow in the dial indicates the location of the effective weight.

The Green Arrow in the dial indicates the location of the Final solution.

Select Remove to see the solution without the trial weight, select Keep to see the solution with the trial
weight.

In the Balance Solution area the Weight / Location of the solution is displayed followed by the
Influence Coefficients.

Below the table the Effective Weight and Location of the solution is listed.

Click        to Clear All Weight from the table.
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File Menu

New eZ-Balance File
Select this menu item to create a new file for your new balance job.

Save As Dialog

Open eZ-Balance File
Select this menu item to open an existing file for your balance job.

Open eZ-Balance File Dialog

Save eZ-Balance File
The Save eZ-Balance File option saves the current state of the project.

Save Snapshot
The Save Snapshot option  saves the current record and stores it in the history file.

Save Runout
The Save Runout option saves the Runout data to file.

Print Screen
The Print Screen menu option opens the Print dialog box for your default printer.

Exit
The Exit menu option closes eZ-Balance.
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Edit Menu

ZonicBook…
When you select ZonicBook on the Edit menu, the ZonicBook Configuration window opens.  This window
has two tabs.  Use the Acquisition Tab to set up the acquisition parameters.  Use the Input Channels Tab to
set the tach and input channels.

Acquisition Tab
Use this panel to configure the ZonicBook’s Acquisition parameters for your eZ-Balance Job

Balance Configuration Acquisition Tab

Block Size: This value is the number of samples per block of data.  For example, a 2048
Block size contains 2048 data samples and will produce an 800 line spectrum.
A larger Block size will provide you with greater data resolution, however, the
larger the Block size, the longer it takes to collect the data.

Analysis Frequency: This value is the maximum frequency of interest.  The sampling rate will be
2.56 times the analysis frequency.  Verify the maximum frequency response of
your probes.  Typically, the analysis frequency will be 500 to 2000 KHz.
If you have a Tach signal, your Analysis Frequency should be a higher multiple
of the maximum rotating speed. Typically, this multiple is at least 10 times the
rotating frequency.

Number of averages: The averaging function is a rolling buffer that averages the last “n” data blocks.
FFT Window: Options are None, Hanning, Flat Top, or Blackman Harris.  Hanning provides

better frequency resolution.  Flat Top provides better amplitude resolution.
No. Balance Planes: eZ-Balance can have between 1 and 7 balance planes.
ZonicBook Input
Module:

Allows the selection of either an 8-Channel or 16-Channel ZonicBook. If a 16-
Channel ZonicBook is selected, only the first 8 channels can be used to acquire
data.

Low Frequency
Cutoff for Single and
Double Integration:

Low frequency cutoff is used to remove the low frequency effects of integration.
All spectral amplitude values below the specified frequency value are set to
zero.
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Input Channels Tab
Use this window to configure each ZonicBook input signal for your eZ-Balance Job.  For each desired
channel set the values for each attribute.

Balance Configuration Input Channels Tab

Type: This is the type of instrument that will be connected to the selected channel. Instrument Types
include Accelerometer, Velocity, X probe, Y probe, Z probe, and Tach.  Make your selection on
the pull down menu.  If no instrument will be connected to this channel select “unused.”
You must have 1 Tach Channel and 1 or more Response Channels.

For each probe configure the Dip Switches on the ZonicBook Input Module for the
appropriate channel.
Most accelerometers are Single Ended, AC Coupled, and ICP On.  Also, verify the
power source for your transducers.
Refer to the ZonicBook Getting Started User’s Manual

 Name: Enter a name, or label, for the selected channel.
Min and Max: Enter the instrument Range:  Minimum and Maximum in engineering units.
Units: Select the engineering Units on the pull down menu.

The available selections are based on the Instrument Type you selected.
Full Scale Voltage: Select the maximum Full Scale Voltage expected for the instrument.

Erroneous results will occur if you select a voltage value that is less than the actual
input voltage.  If you are unsure of the instrument’s maximum voltage value,
select a high voltage value.  (i.e.: 20V)

mV/EU: This is the instrument’s input Sensitivity.  Typical accelerometers have a
sensitivity of 100 mV per g; and displacement probes have 200 mV per mil.
For Tach probes enter 1000 mV per Volt.

Integration: Accelerometer and Velocity signals can be integrated. Select the desired
“integration” value. If the signal is acceleration, then single integration results in
velocity, and double integration results in displacement.  If the signal is velocity,
then single integration results in displacement.

Int/Units: Select the engineering units to be used after integration from the pull down menu.
Angle: This is the physical angular location of a probe.

Zero degrees is defined to be TDC (+y-axis). The angle value is measured in the
counterclockwise (CCW) direction.  Typically viewed from the driver end.
For example, if your proximity probe is located at the 10 o'clock position
(45 degrees) of the bearing housing, the Instrument Angle is 90 degrees.
Instrument angle is used for data display correction.

Gap Volt: The DC gap voltage reference value when the shaft is at rest.  DC coupling must
be enabled to measure the DC voltage value.
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1xARef and
1xPRef:   

The 1x (first order) Amplitude and Phase values are used for
Runout Compensation on Bode or Polar displays.  These values are commonly
known as Slow Roll Compensation values and should be collected during machine
slow roll conditions (i.e.: Speeds < 500 rpm).  The values must be between the
Maximum and Minimum EU range.

For Tach Probes, you will need to enter the following information:

Rotation: Select the machine’s Rotation Direction, either CCW (counter-clockwise) or
CW (clockwise) on the pull down menu.  The rotation direction is typically
viewed from the driver end.  Rotation direction is used for data display correction.

Trig/Rev: Enter the number of tach trigger pulses per shaft revolution.  This number must
be 1 for all Balance Jobs.  Phase can not be calculated if the number of trigger
pulses is greater than 1.

Trig Dir: Select the tach’s trigger pulse direction, either Neg(ative) or Pos(itive) on the
pull down menu.  Typically this is the direction of the tach signal’s leading edge.
Trigger voltage and direction define the start of a shaft rotation.
A keyway will generate a Negative Tach pulse.

Trig Volt: The tach’s Trigger Voltage number must be less than the tach’s FSV.  A tach
pulse is recognized when the tach signal exceeds the trigger voltage in the trigger
direction specified.  Trigger voltage and direction define the start of a shaft
rotation.  Typical Tach signals will generate at least a 1 V pulse.

Input Channel Tab - Edit Menu
Set Defaults: Sets instrument’s attributes to the default values, based on the defined instrument

type.
Copy Channel: Copies the channel attributes of the channel where the cursor is currently residing.
Paste Channel: Pastes the copied channel attributes to the channel where the cursor is currently

residing.
Fill Down: Copies the channel attributes of the channel where the cursor is currently residing

and copies them to all succeeding channels that are not marked “unused.”
Fill Up: Copies the channel attributes of the channel where the cursor is currently residing

and copies them to all preceding channels that are not marked “unused.”

Load Machine Graphic
The Load Machine Graphic menu option allows you to insert a .jpg or .bmp file in the Machine Picture
window.

Use standard Microsoft Windows techniques to find your Machine graphic.

Load Machine Graphic Dialog Machine Graphic Panel
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Remove Machine Graphic
Select the Remove Machine Graphic to delete the machine picture from the Machine Picture window.

Balance Toolkit
The Toolkit provides a variety of useful balance calculations.  Select the Balance Toolkit option or press
the < Toolkit > button,          , located to the left of the plot, to activate the Toolkit.

There are 10 Tabs in the Toolkit.  Each Tab accesses a specific balance calculation.  Click on the desired
Tab to bring it to the foreground.  Throughout the Tabs, you have the option to work in English or Metric
Units.  The selection of English or Metric units applies to all Tabs.

Trial Wt Calc Tab

Trial Wt Calc Tab

This panel calculates the weight needed to generate a force equal to 10% of the rotor weight given the
rotor radius, weight, and rpm’s.

Find Trial Weight

Enter the rotor radius, weight, and rpm’s.

If the rotor is near resonance, a force equal to 10% of the rotor will have too large of an
effect.  If there is past sensitivity data available, it should be used.
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Split Weights Tab

Split Weights Tab

Find Split Weights

Sometimes you need to add a weight at a specific angular location, but there is no place to physically
mount the weight.  This panel calculates the amount of weight to install at alternate locations, so that the
effect will be equivalent to the original amount of weight required by your calculations.

Spread Angle Method

Enter the amount of weight to be added, the angle closest to the original angular position required by your
calculations, and the spread angle.

Upper/Lower Angles Method

Enter the amount of weight to be added, the desired effect angle that was derived in your original
calculations, the upper angle, and the lower angle.
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Resolving Weights Tab

Resolving Weights Tab

This panel calculates the effect of placing multiple weights at multiple locations.

Enter the weight and angular position (in degrees) of each balancing weight.

A graphical representation of the data entered is displayed to the left with blue circles.
The resultant is displayed as a red circle.  The resultant weight and angle are displayed below the clear
and Clear Last buttons.

Chord-Angle Arc Tab

Chord-Angle Arc Tab

This panel calculates the Chord, Angle, or Arc when the radius and one of three variables is known.

You are prompted to enter the radius and the value of the known variable.  For example, if you select
“Angle” from the “Given” menu and "Chord" from the "Find" menu, you will be prompted to enter the
radius and angle.  The Chord value is then displayed in the lower right section.
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Runout Subtract Tab

Runout Subtract Tab

Find Compensated Amplitude and Phase

This panel vectorially subtracts the runout measured at low speed from the runout measured at balancing
speed.  Runout must be compensated for prior to balancing.

This calculation can also be used to determine the actual amount of vibration that is present in the system.

Enter the amplitude and phase for balancing speed (V1) and slow roll (V2).

Compensated amplitude and phase (V3) are calculated after each data entry.
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Centrifugal Force Tab

Centrifugal Force Tab

Find Force

This panel calculates the centrifugal force generated by a weight.  This calculation can be used to determine
the expected amount of motion if the radius, unbalance amount, and dynamic stiffness of the structure are
known.

Enter the amount of weight added in ounces or grams, the radius (distance from the center to weight), and
the rotor rpm.
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Unbalance Tolerance Tab

Unbalance Tolerance Tab

This panel calculates the acceptable amount of residual unbalance.

Selecting the Balance Grade

This menu allows you to select from a list of ISO balance grade standards.

When a balance grade is selected, an example of equipment normally associated with the selected grade is
displayed.  Select the appropriate balance grade to calculate the acceptable amount of residual unbalance
that will allow a rotor to fall within the ISO balance grade criteria.

Find Unbalance Tolerance

Enter rotor weight and speed.

The Upper Limit for rigid frames and the Lower Limit for flexible frames is displayed at the bottom of the
window.
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Stock Weights Tab

Stock Weights Tab

Selecting the Stock

This menu allows you to select the stock type. Select flat or round.  Note that the graphic below changes
based on your selection.

Find Weight of Stock

This panel calculates stock weight given the length, width/diameter, and thickness of a specified material.
Enter the stock length, width/diameter, and thickness/diameter.

Find Length of Stock

This panel calculates stock length given the weight, width/diameter, and thickness of a specified material.
Enter the stock weight, width/diameter, and thickness/diameter.



ZonicBook 10-30-01 eZ-Balance, pg.  29

Drill Bit Weight Tab

Drill Bit Weight Tab

Find Weight

This panel calculates the weight removed by a drill bit for various materials given a specified drill bit
diameter and depth.

Enter the Drill Bit Diameter and the Drill Depth.

Selecting the Material

This menu allows you to select from a list of various materials.

Find Depth

This panel calculates the drill depth needed to remove a specified amount of weight for various materials.

Enter the Drill Bit Diameter and the Weight Removed.
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Arc Weight Tab

Arc Weight Tab

Effect of Weight Added

This panel calculates the effect of weight added over an arc.

Enter the arc length, weight added, and arc radius.

Find Desired Effect

This panel calculates the weight needed to cause a desired effect.

Enter the desired weight effect, weight radius, and weight per unit length
(desired weight divided by arc length).

Copy Display Window
The Copy Display Window option copy the Main window with all its sub-windows to the clip board.  It can
then be pasted into other report applications, such as Microsoft Word.
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Report Menu

Balance Results
The Balance Results menu option opens the Save As Menu.  Type a name for your report and click the
Save button.  A text file of your results is created and saved.  The report can be opened with
Microsoft Word or Notepad.

Save As Balance Result Report Balance Result Report



eZ-Balance, pg. 32 10-30-01 ZonicBook

Balance Configuration
The Balance Configuration menu option opens the Save As Menu.  Type a name for your report and click
the Save button.  A text file of your configuration is created and saved.

Save As Balance
Configuration Report

Balance Configuration Report

Acquisition Menu

Start / Stop Acquisition
You can start and stop acquisition with this menu option or with the On/Off toggle switch       /            in the
Main window.

Pause / Continue ACQ
You can pause and continue data display with this menu option or with the Pause/Continue toggle
button        /        in the Main window.

Control Menu

Clear All Runs
The Clear All Runs menu option deletes all the vibration data from the Polar Display window.
 You can also click the       to clear all runs.

Clear Current Run
The Clear Current Run menu option deletes the current (last entered) vibration data from the Polar Display
window. You can also click       to clear the last run.
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Save Current Run
Use this menu option to save the current (last) run.

Begin Next Run
Use this menu option to start the next run.

Calc Balance Solution
This menu item calculates the balance solution and displays the information in the Balance Weights
window.  You can also click       .

Add Sol Wts to Bal Plane
This menu item adds Solution Weights to the Balance Weights window.

Window Menu

Add Vib Plot Window
This menu item opens a Polar Display window each time it is selected.

Polar Display Window
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Add Bal Weights Window

Balance Weight Window

This menu item opens a Balance Weight window each time it is selected.

Show Control Window
This menu item opens the Show Control window.

Control Window
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Show Machine Graphic
This menu item open the Machine Picture window.

Machine Graphic Window

Show Comments
This menu item opens the Comments window.

Comments Window

Cascade
This menu item places multiple plot windows (starting from the upper left corner of the screen) slightly
down and to the right of the prior window.

Tile Horizontal
This menu item Tiles multiple plot windows across the screen.

Tile Vertical
This menu item tiles multiple plot window from the top to the bottom of the screen.
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Tips and Tricks
Here is a list of common suggestions for you to use eZ-Balance more effectively.

1. It will save time, if you modify the eZ-Balance Job in the executable’s directory to match your
standard configuration.  This is the Job Template.  Whenever you create a New Job, the Job
Template is copied into your new Job.

2. Make sure your ZonicBook Dip Switches are configured correctly.
3. Use a standard channel location convention for your Tach and Response channels.  (Typically:  Tach

is channel 1 and Response channels are 2 through 8.)
4. If you aren’t getting a Tach Trigger, verify the Tach channel’s FSV and Trigger Level Percentage

and Direction.
5. If for some reason, you have an error where eZ-Balance does not boot up.  You can delete the file,

“EZBal.ini”, located in the executable’s directory.  This file identifies the last Job opened.  You can
delete this file without affecting your data.  Try reopening the last Job.

6.  If you still experience problems.  You can send an e-mail to productsupport@iotech.com .

mailto:productSupport@iotech.com
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